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Geltungsbereich 

 

 

 

Aus Gründen der besseren Lesbarkeit wird auf die gleichzeitige Verwendung der Sprachformen männlich, 

weiblich und divers (m/w/d) verzichtet. Sämtliche Personenbezeichnungen gelten gleichermaßen für alle 

Geschlechter. 

 

Dieses Dokument ergänzt die Vorgaben zur Anwendung der BIM-Methodik für BIM-Projekte der 
DB InfraGO Personenbahnhöfe AG und ist für die Georeferenzierung in BIM-Projekten der DB 
InfraGO AG – GB Personenbahnhöfe verbindlich anzuwenden. Dieses Dokument beinhalten Hin-
tergrund, Vorgaben zum Koordinatensystem Personenbahnhöfe sowie Umsetzungsbeispiele für 
verschiedene Autorensoftwaren. 

Das vorliegende Dokument Georeferenzierung bei DB Personenbahnhöfen in BIM-Projekten ist 

urheberrechtlich geschützt. Der DB InfraGO AG – GB Personenbahnhöfe steht an diesen Vorgaben das 

ausschließliche und uneingeschränkte Nutzungsrecht zu. 

Jegliche Formen der Vervielfältigung zum Zwecke der Weitergabe an Dritte bedürfen der Zustimmung 

der DB InfraGO AG – GB Personenbahnhöfe durch die geschäftsverantwortliche Stelle. 
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1 Einleitung 

1.1 Ziel und Zweck 

Die systematische, geometrische Abweichung zwischen 3D-Planung und Vermessung soll durch 

die optimale Definition eines Koordinatenreferenzsystems (CRS1) minimiert werden. Die systemati-

schen Abweichungen entstehen, da in 3D-Planungssoftwaren die Erdkrümmung nicht berücksichtigt 

wird. Mit dem neuen Verfahren wurde für jede Verkehrsstation ein lokales CRS erstellt. Dieser Typ 

von CRS wird lokales Koordinatensystem Personenbahnhöfe (VA-System) genannt. 

 

Die dreidimensionale Planung und Modellkoordination ist neben dem Informationsmanagement we-

sentliches Moment des Building Information Modeling (BIM). Die dreidimensionale Vermessung des 

Bestandes ist die Grundlage der dreidimensionalen Modellierung. 

Die Umformung der lokalen Koordinatensysteme Personenbahnhöfe (VA-Systeme) zum DB_REF 

ist einfach anzuwenden und standardisiert. Das geodätische Datum und die hohe Netzqualität des 

DB_REF bleiben erhalten. Statt einer globalen Gauß-Krüger Abbildung mit 3°-Meridianstreifen fin-

det beim Koordinatensystem Personenbahnhöfe (VA-System) pro Personenbahnhof eine lokal opti-

mierte kartographische Projektion statt. Das lokale Koordinatensystem Personenbahnhöfe nutzt als 

Grundlage das DB einheitliche Referenzsystem DB_REF. Dadurch ist insbesondere der Trassenbe-

zug garantiert. Hauptgegenstand ist die einheitliche Definition eines lokalen CRS für einen Maßnah-

menbereich. 

Weitere vermessungstechnische Motive, das neue Koordinatensystem Personenbahnhöfe (VA-Sys-

tem) als führendes Koordinatenreferenzsystem einer Maßnahme einzuführen, werden Unterab-

schnitt 3.1 beschrieben. 

 
1 es wird das englische Akronym CRS für coordinate reference system verwendet 
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2 Koordinatensystem Personenbahnhöfe (VA-System)  

Im Folgenden wird nur begründet, warum bestimmte geodätischen Konzepte für das Erstellen der 

Datenbank für die Koordinatensysteme Personenbahnhöfe verwendet werden. Dabei geht es um 

Konzepte der 

▪ Datumsfestlegung und Datumstransformation für Lage-, Höhe- und 3D-Koordinaten 

▪ Art und Umfang von digitalen Schwere- und Geländemodellen 

▪ Streckenreduktionen aufgrund der Projektion und Streckenreduktionen aufgrund der Höhe. 

Die praktischen Arbeitsschritte für das BIM Management, Vermessung und Modellierung werden in 

Abschnitt 3 beschrieben. 

2.1 Allgemeine Grundlagen 

2.1.1 Analyse des geodätischen Kontexts 

Das lokale Koordinatensystem Personenbahnhöfe ist ein einfach zu verwendendes Koordinatensys-

tem, das die Vorteile des deutschlandweiten DB_REF Systems mit den Vorteilen eines lokalen Ko-

ordinatensystems vereint. In der Analyse werden unterschiedliche methodische „Bausteine“, die das 

Koordinatensystem Personenbahnhöfe nutzt, in zahlreichen Publikationen diskutiert. 

Einen allgemeinen Überblick zur Georeferenzierung von Modellen findet man im Kapitel Georefe-

renzierung [Clemen et al. 2022] im DVW Leitfaden "Geodäsie und BIM"2. Der Beitrag gliedert die 

Aufgaben der Georeferenzierung in mathematische, pragmatische und IT-Aspekte. Es werden ver-

schiedene Transformationsansätze zwischen BIM und Vermessung/GIS diskutiert. Im DVW Leitfa-

den Geodäsie und BIM wird im Beitrag Arbeiten im „lokalen CRS“ [Heuer 2022] ein Workflow des 

Wasserstraßen-Neubauamt Berlin (WSV) vorgestellt, der, wie das Koordinatensystem Personen-

bahnhöfen (VA-System), auf einer lokalen Projektion für die Lagekoordinaten basiert. Besonders 

interessant ist, dass Heuer [2022] auch die praktische Umsetzung in BIM Software in realen Projek-

ten beschreibt. 

Die speziellen Probleme, wenn globale CRS für die 3D-Modellierung langgestreckter Anlagen 

(Schienenwege) verwendet werden, werden u.a. in Jaud et al. [2020] thematisiert. Die Autoren ge-

hen speziell auf die Maßstabsproblematik ein und zeigen auch, wie sich falsch interpretierte Koordi-

naten auf die Volumenberechnung, zum Beispiel von Erdmassen, auswirken. Clemen und Manthe 

[2015] haben bereits ein lokales Koordinatenreferenzsystem für das BIM-Pilotprojekt Erneuerung 

Hauptbahnhof Hannover empfohlen. 

In der wissenschaftlichen und technischen Literatur finden sich zahlreiche Verfahren für lokale CRS, 

die alle das Ziel haben, die Verzerrungen aufgrund der Erdkrümmung lokal zu minimieren. Dennis 

[2016] zeigt, wie sich im Kontext von Low Distortion Map Projections unterschiedliche Projektionsty-

pen auswirken. Andere Autoren, z.B. Baselga [2021], entwickeln komplexe Verfahren für Gebiete 

großer Höhe indem sie die Ellipsoiddimension (a,b) für lokale Messungen anpassen. Einen Über-

blick über die unterschiedlichen Konzepte der Ellipsoidanpassung gibt Rollins und Meyer [2019]. 

Weitere Publikationen vergleichen mögliche Rechenflächen für die Vermessungspraxis mit dem Ziel 

eine klare Begrifflichkeit zu entwickeln [Billings 2013]. Wichtige Argumente für die Berücksichtigung 

 
2 http://www.dvw.de/BIM-Leitfaden.pdf 

http://www.dvw.de/BIM-Leitfaden.pdf
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der Höhe bei der CRS Konzeption beschreiben die älteren Untersuchungen zur erforderlichen Hö-

hengenauigkeit bei der Bestimmung des Maßstabfaktors k0 von Burkholder [2004]. 

2.1.2 Allgemeine geodätische Konzepte 

Wie in Abbildung 1 schematisch dargestellt, stellt die Definition eines Koordinatenreferenzsys-

tems den geometrischen Bezug zwischen 3D-Geometrie der Verkehrsanlage (VA) und Erdkör-

per dar. 

 

Abbildung 1 Die Lage des Koordinatenreferenzsystem für BIM Projekte muss präzise und eindeutig bezüglich der 3D-Pla-

nung und dem Erdkörper definiert werden. 

 

Die Wissenschaft der Geodäsie liefert die mathematischen, physikalischen und konzeptionellen 

Grundlagen für praktische Vermessungsarbeiten. Die in Abbildung 2 schematisch dargestellten 

geodätischen Grundlagen sind für das Verständnis der neuen Koordinatensystem Personen-

bahnhöfe (VA-Systeme) erforderlich: 

 

▪ Umrechnung von erdbezogenen dreidimensionalen, kartesischen Koordinaten 

(X,Y,Z) in ellipsoidischen Koordinaten (λ,φ,h) 

▪ Streckenreduktion zur Anpassung einer Horizontalstrecke in der Örtlichkeit in die 

projizierten Koordinaten (z.B. Gauß-Krüger Koordinaten). Die Streckenreduktion 

muss aufgrund der kartographischen Abbildung und der Höhe der Strecke über dem 

Referenzellipsoid an gemessenen Strecken angebracht werden, damit gemessene 

Strecke und Koordinaten zusammenpassen. 
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Abbildung 2 Für die meisten praktischen Aufgaben werden Punkte aus der dreidimensionalen Welt nach Lage und Höhe 

getrennt. Links: Umwandlung kartesischer Koordinaten (X,Y,Z) in ellipsoidische Koordinaten (λ,φ,h). Rechts: Die gemes-

senen Strecken (Baustelle) verjüngen sich auf der zweidimensionalen Rechenfläche (Karte/CAD) 

 

Besonders wichtig für das Koordinatensystem Personenbahnhöfe ist die kartographische Pro-

jektion. Diese wird zur Umrechnung ellipsoidischer Koordinaten (λ,φ) in projizierte Gebrauchsko-

ordinaten nach Rechtswert, Hochwert (GK) bzw. Easting/Northing (UTM) verwendet. Das 

DB_REF verwendet eine Gauß-Krüger-Abbildung mit 3°-breiten Meridianstreifen (siehe Abbil-

dung 3). Das Koordinatensystem Personenbahnhöfe unterscheidet, genauso wie das DB_REF, 

zwischen kartographisch projizierten Lagekoordinaten und schwerefeldbezogenen Normalhö-

hen. Für die Umrechnung zwischen geometrischen Höhen h und physikalischen Normalhöhen 

(N) benötigt man das Schwerefeld der Erde (siehe Geoid Abbildung 3). Das Geoid wird durch 

das Quasigeoid approximiert. Das Quasigeoid wurde von der amtlichen Vermessung mittels 

Schweremessungen modelliert. 

 

Abbildung 3 So wie das DB_REF verwendet das VA-System projizierte Lagekoordinaten (2D) und schwerefeldbezogene 

Normalhöhen H (1D). Links: Um zu große Verzerrungen bei der kartographischen Projektionen (λ,φ)→(x,y)  zu vermeiden, 

werden traditionell Meridianstreifen gebildet. Diese werden getrennt projiziert. Rechts: Die Gebrauchshöhen H beziehen 

sich auf das, durch physikalische Schwere definierte, Geoid3. 

 

 
3 Bildquelle https://de.wikipedia.org/wiki/Geoid 
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2.1.3 DB_REF 

Mit der DB Richtlinie 883.2000 ist die Verwendung des DB_REF Datums bei der Deutschen Bahn 

geregelt. Darüber hinaus beschreibt die Richtlinie 883.2500 die Verwendung des DB_REF für BIM 

Projekte mit Trassendaten. Das geodätische Datum des DB_REF wurde bestmöglich an das 

DHDN90 angepasst und ist aus dem ETRS89 ableitbar. 

Für die homogene Datumstransformation4  zwischen DB_REF und ETRS89 sind zwei Parameters-

ätze (Tabelle 4) durch die Richtlinien definiert. 

 
Tabelle 1 Transformationsparameter DB_REF / ETRS89 gemäß Richtlinie 883.9010 

 DB_REF nach ETRS89 ETRS89 nach 

DB_REF 

∆x [m] +584,9636 -584,9567 

∆y [m] +107,7175 -107,7277 

∆z [m] +413,8067 -413,8036 

rx ["] -1,1155214628 +1,1155257601 

ry ["] -0,2824339890 +0,2824170155 

rz ["] +3,1384490633 -3,1384505907 

m [ppm] +7,992235 -7,992171 

 

Zusätzlich ist für das DB_REF2016 festgelegt, dass Normalhöhen verwendet. 

 
Tabelle 2 Relevante EPSG-Codes (ab Version v10.042) 

EPSG Code Bezeichnung 

5681 DB_REF Geographisch 2D 

5828 DB_REF Geozentrisch 

5830 DB_REF Geographisch 3D 

5682 DB_REF GK Zone 2 

5683 DB_REF GK Zone 3 

5684 DB_REF GK Zone 4 

5685 DB_REF GK Zone 5 

9932 DB_REF GK Zone 2 + GNTRANS2016 Höhen 

9933 DB_REF GK Zone 3 + GNTRANS2016 Höhen 

9934 DB_REF GK Zone 4 + GNTRANS2016 Höhen 

9935 DB_REF GK Zone 5 + GNTRANS2016 Höhen 

4258 ETRS89 Geographisch 2D 

4936 ETRS89 Geozentrisch 

4937 ETRS89 Geographisch 3D 

9927 GNTRANS2016 Höhen 

7837 DHHN2016 Höhen 

 
4 Die Umrechnung erfolgt bei der 7-Parameter Transformation ohne Homogenisierung, also ohne eine lokale Restklaffenanpassung wie 
sie beim Übergang von DHDN ins DB_REF nötig ist und z.B. mit der Software GNTRANS realisiert ist. 
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Diese lassen sich direkt aus den ellipsoidischen ETRS89 Höhen, reduziert um die Quasigeoi-

dundulation aus dem GCG2016 Geoid-Modell, berechnen. Diese Höhen weichen nicht mehr als 

1cm bis 2cm von den Höhen aus dem aktuellen deutschen Höhensystem DHHN2016 ab.5 

2.1.4 EPSG Definitionen, Umrechnungen und Transformationen 

Für Geographische Informationssysteme (GIS) haben sich die sogenannten European Petro-

leum Survey Group Geodesy (EPSG) Codes etabliert. Die Codes und Parameter werden der-

zeit durch das Geomatics Committee der International Association of Oil & Gas Producers 

(IOGP) verwaltet. Alle Parameter sind auf der EPSG-Webseite6 verfügbar. Die Formeln zur Ko-

ordinatenumrechnung und -transformation sind als kostenloser PDF-Download [International 

Association of Oil & Gas Producers (IOGP) 2022] auf der IOGP Webseite erhältlich 7. 

Mit den EPSG Codes erhält man eine eindeutige Definition von Koordinatenreferenzsystemen 

(CRS) und Transformationsparametern zwischen den Systemen. Wenn die EPSG-Codes einem 

Datensatz zugeordnet werden, können GIS-Systeme raumbezogene Daten mit unterschiedli-

chen Koordinatenreferenzsystemen erfassen, verwalten, analysieren und visualisieren. Die für 

DB InfraGO AG – GB Personenbahnhöfe relevanten Codes sind in Tabelle 2 aufgelistet. Mit 

diesen Codes und den später vorgestellten CRS/WKT-Definitionen der lokalen Koordinatensys-

tem Personenbahnhöfe können viele Softwaresysteme automatisiert und einheitlich zwischen 

den CRS-Systemen DB_REF/GK ↔ Koordinatensystem Personenbahnhöfe umrechnen. 

Zusätzlich definiert EPSG Code 5826 die Umwandlung von DB_REF nach ETRS89. Allerdings 

sind die Parameter der Transformation in der EPSG Datenbank gekürzt und für beide Transfor-

mationsrichtungen identisch. Die Auswirkung der Differenz zu der Originaltransformation ist in 

der Regel kleiner als 1mm je Koordinatenachse, also im Normalfall vernachlässigbar. Kommt es 

allerdings auf Millimeter-Genauigkeit an, sollte man die exakten Transformationsparameter aus 

verwenden. 8 

2.2 Lokales Koordinatensystem Personenbahnhöfe (VA-System) 

2.2.1 Grundsätze 

Die Parameter in der Koordinatensystem Personenbahnhöfe (VA-System) Datenbank paramet-

rieren eine automatisierte Umformung von DB_REF Koordinaten zum lokalen System und zu-

rück. Die Umformung der Koordinaten kann mit Standardsoftware durchgeführt werden. Die Pa-

rameter (Werte der VA-System Datenbank) wurden unter folgenden Prämissen berechnet: 

• Die Parameter beschreiben ein aus Lage und Höhe zusammengesetztes (engl. compound) 

2D+1D Koordinatenreferenzsystem (CRS).  

 
5 In der älteren Variante DB_REF2003 beziehen sich die Normalhöhen auf das EGG97DB_REF 

6 https://epsg.org/home.html 

7 https://www.iogp.org/bookstore/product/coordinate-conversions-and-transformation-including-formulas/ 
8 Bei der 7-Parameter-Transformation gibt es zwei Versionen: Die Vorzugsvariante ist die korrekte Implementierung mit trigonomet-

rischen Funktionen in der Rotationsmatrix. Eine näherungsweise Berechnung mit linearisierten Rotationswinkel berechnet die 

Ergebnisse nach Erfahrungswerten mit einer Differenz kleiner als 1mm. 

https://epsg.org/home.html
https://www.iogp.org/bookstore/product/coordinate-conversions-and-transformation-including-formulas/
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• Das geodätische Datum des DB_REF (Lagerung und Ellipsoiddimension) bleibt unverändert. 

Es findet keine geodätische Datumstransformation statt. 

• Es wird lediglich die (kartographische) Projektion angepasst. Der Mittelmeridian λ0 einer trans-

versalen Mercator-Projektion läuft durch die gegebenen geographischen Koordinaten der 

Verkehrsanlage. 

• Der Ursprung der Projektion ist durch Breiten- und Längengrad (φ0,λ0) definiert. Die lokalen 

VASystem Koordinaten erhalten einen Zuschlag in Ostrichtung fE = 5000m und in Nordrich-

tung fN = 10000m damit negative Koordinatenwerten im Maßnahmenbereich vermieden wer-

den. 

• Der Maßstab k0 der Mercator-Projektion wird so optimiert, dass die Differenz zwischen ge-

messener Horizontalstrecke und aus Koordinaten gerechneter Strecke in der Projektionse-

bene lokal minimiert wird. Ausschließlicher Einflussfaktor für k0 ist die Höhe des Projektgebie-

tes. 

• Die Höhen des Koordinatensystem Personenbahnhöfe (VA-Systems) sind identisch mit 

DB_REF2016. 

Mit diesen Prämissen wird das Ziel erreicht, die systematischen Abweichungen zwischen 

Vermessung und 3D-Software zu minimieren.9 Abbildung 4 verdeutlicht wie zwischen den ge-

gebenen Systemen transformiert werden kann. Zusätzlich kann eine weitere Transformation 

zwischen VA und VA+-System durchgeführt werden. Diese ist jedoch nur als Sonderfall (siehe 

Unterabschnitt 0) zu betrachten, wenn eine Vermessung zeitlich vor der Netzverdichtung im 

DB_REF-Punkten erfolgen musste. 

 

Abbildung 4 Schema des Transformationsablaufes 

 

 
9 Das lokale VA-System berücksichtigt keine Lotabweichungskomponenten und ist deswegen zum Beispiel für große geodätische Grund-

lagennetze im Tunnelbau ungeeignet. 
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Die meisten Anwendungen im GIS-Bereich ermöglichen eine Umrechnung zu projizierten Syste-

men über standardisierte und einfach zugängliche Verfahren (wie zum Beispiel Proj-Strings). 

Aufgrund des Höhenproblems bei topozentrischen Koordinaten verwendet das Koordinatensys-

tem Personenbahnhöfe (VA-System) Variante 2, also ein projiziertes Koordinatensystem für die 

Lage und das amtliche Höhensystem für die Höhe (2D+1D).  

2.2.2 Art der konformen Projektion 

Um bei der Projektion der Koordinaten keine Formveränderungen zu erhalten, wird eine kon-

forme Projektion10 verwendet. Diese garantiert eine fehlerfreie Abbildung der Richtungen. Die 

minimalen, aber unvermeidbaren Streckenverzerrungen bei Entfernung vom Projektionszentrum 

der Transversalen Mercator Projektion sind formelmäßig einfach zu handhaben. Da das Koordi-

natensystem Personenbahnhöfe (VA-System) nur lokal im Maßnahmenbereich benutzt wird 

(<1km), sind diese Verzerrungen in der Praxis vernachlässigbar. 

 

 

2.2.3  Die Höhe 

 

 

Abbildung 5 Wegen der Erdkrümmung (und dem Erdschwerefeld) unterscheiden sich die Ebenen Z=konstant und H=kon-

stant. Auf 1000 m beträgt der Abbildung 5Unterschied etwa 7,8 cm. Wird die Vermessungshöhe H gleich der kartesischen 

Koordinate Z gesetzt, hat das für die objektstrukturierte Bauwerkmodellierung nur sehr geringe Abweichungen zur Folge. 

Zum Beispiel wäre für ein Bauteil mit den Maßen 10 m Höhe x 100 m Länge der Fugenunterschied zwischen Ober und 

Unterseite nur 0,2 mm. 

 

Wir empfehlen, die Normalhöhe H auch als Höhe Z in der Modellierungssoftware einzusetzen, 

damit: 

• Vermessung und Modellierung die gleichen Höhenwerte ohne Umrechnung verwenden 

können. 

• Die Höhen zwischen 3D-Modellierung und Trassierung ohne Umrechnung vergleichbar 

sind 

 
10 Die konformen Projektionen sind Transverse-Mercator-Projektion und Lambert-Conic-Conformal-Projektion. Beide Projektionen liefern 

bei der kleinen Ausdehnung des Gebietes eines VA-Systems nahezu (im Bereich 1/100 mm) identische Koordinaten. Für das VA-System 

wird die Transverse-Mercator-Projektion verwendet, weil diese vermutlich in allen Softwareanwendungen gut funktioniert und weniger 

Konfigurationsparameter enthält. 
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• Waagerechte Bauteile auch tatsächlich waagerecht abgesteckt werden 

Die Abweichungen aufgrund der (sehr geringen) Krümmung von ca. K=1/6380000 m der xy-

Ebenen kann bei einer bauteilstrukturierten Modellierung vernachlässigt werden, wie das Bei-

spiel in Abbildung 5 zeigt. 

2.2.4 Optimaler Maßstabsfaktor 𝒌𝟎 

Zur Definition des Koordinatensystems Personenbahnhöfe (VA-Systems) gehört der Maßstabs-

faktor k0. Dieser ist so zu definieren, dass die Differenz zwischen den lokal gemessenen Stre-

cken und den Strecken im Koordinatensystem Personenbahnhöfe (VA-System) minimiert wird. 

Ausschließlicher Einflussfaktor für k0 ist die Höhe. Die Referenzhöhe h0 für die Maßstabsfestle-

gung k0 wird über die DGM-Höhen in der weiteren (Kategorie 1-3) oder nahen (Kategorie 4) Um-

gebung des Koordinatenursprungs (λ0,φ0) festgelegt. 

 

2.3 Eingabe, Ausgabe und Struktur der Datenbank 

Als Eingangsdaten liegen die von der DB InfraGO AG – GB Personenbahnhöfe bereitgestell-

ten CSV-Dateien der Bahnhöfe vor. 
Tabelle 3 Struktur Eingabedaten (CSV-Datei der DB InfraGO AG Personenbahnhöfe) 

Spalte Merkmal Bemer-

kung 

1 Breite φ0 WGS84 11 

2 Länge λ0 WGS84 

3 Bahnhofs-ID  

4 Bahnhofname  

5 Bahnhofskategorie  

6 vorgegebene Höhe  

7 Position im DB_REF (ja/nein) 

 

Damit lassen sich wie oben beschrieben die Parameter des lokalen Koordinatensystems Perso-

nenbahnhöfe (VA-Systeme) berechnen.12 

Wichtigste Ausgabe sind die WKT-Strings für die berechneten Koordinatensystem Personen-

bahnhöfe (VA-Systeme). Als eindeutiges Kennzeichen der einzelnen Bahnhöfe (Verkehrsanla-

gen VA) wurde die Bahnhofs-ID im Dateinamen und als Namensparameter verwendet. Die 

 
11 Die WGS84 Koordinaten sind mit drei Nachkommastellen gegeben. Das entspricht ca. 111m in Nord-Süd Richtung. Wegen der 

Unschärfe des WGS84 wurde festgelegt, dass die gegebene Koordinate als ETRS89 interpretiert werden kann. Die Koordinaten 

wurden von der DB InfraGO AG – GB Personenbahnhöfe bereitgestellt. 

12 Für die Zuordnung der Bahnhofskategorie wurde noch eine CSV Datei mit Nummer; Name; city; zipcode; street; category; regio-

nalbereich_Number; regionalbereich_Name; regionalbereich_ShortName von der DB InfraGO AG GB Personenbahnhöfe bereitge-

stellt. 
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Datenbank ist ein Ordner mit Unterverzeichnissen (siehe Abbildung 6). Die Unterverzeichnisse 

sind mit den Bahnhofs-IDs mit führendem Nullen bezeichnet. 

 

 

Abbildung 6 Verzeichnisstruktur und Parameterdateien der VA-System Datenbank. Beispielhaft ist VA_0001 HbfAachen 
und eine Darstellung des Koordinatensystem Personenbahnhöfe (VA-Systems) im XML-Format für Autodesk Produkte 
ausgewählt.  

Zusätzlich wird eine CSV-Datei im übergeordneten Ordner ausgegeben, die nochmals sämtli-

che Bahnhöfe mit folgenden Spalten enthält: 

Tabelle 4 Struktur VA-System Datenbank (CSV-Datei) 

Spalte Merkmal Bemerkung 

1 Station_ID die Bahnhofs-ID (+ evtl. Revisionsnummer) 

2 Station_Name der Bahnhofsname 

3 Station_Category die Bahnhofskategorie 

4 lat0 Ursprungsbreitengrad der Projektion im DB_REF 

5 lon0 Mittelmeridian der Projektion im DB_REF 

6 fE Additionswert des Rechtswertes der Projektion 

7 fN Additionswert des Hochwertes der Projektion 

8 k0 Maßstabsfaktor im Ursprung der Projektion 

9 h0 verwendete ellipsoidische Höhe für den Maßstab 

10 H0 Normalhöhe des Zentrums bzw. des Medians des Gebietes 

11 Undulation Geoidundulation im Zentrum bzw. des Medians des Gebietes 

12 ppm_Max Maximale Maßstabsabweichung durch Höhenunterschied 

13 ppm_Range Spanne der Maßstabsabweichung durch Höhenunterschied 

14 ppm_Avg Mittelwert der Maßstabsabweichung durch Höhenunterschied 

15 ppm_StdDev Standardabweichung der Maßstabsabweichung durch Höhenunter-

schied 

 

Die letzten vier Spalten (12-15 in Tabelle 4) werden nur bei Bahnhöfen der Kategorien 1 bis 3 

berechnet, sonst bleiben die Spalten leer. Für jede Verkehrsanlage ist ein Unterverzeichnis 

angelegt, das die berechneten Parameterdateien für unterschiedliche Softwaresysteme ent-

hält. Das Well Known Text (WKT) Format für Koordinatenreferenzsysteme (CRS) ist ISO 

19162:2019 [2019] spezifiziert. Allerdings haben sich in der Praxis viele Formatdialekte als 

Varianten entwickelt. Folgende Varianten der WKT-Strings werden erzeugt, damit die Daten-

bank auf möglichst vielen CAD/GIS/BIM Systemen eingesetzt werden kann: 
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Tabelle 5 Die VA-System Datenbank enthält pro Verkehrsanlage (VA) mehr als fünfzehn Formatvarianten für die Be-
schreibung der berechneten Parameter 

Dateiname Formatbeschreibung 

VA_[Bahnhofs-ID]_Autocad.xml Parameter für AutoDesk Produkte 

VA_[Bahnhofs-ID]_2D_WKT1_SIM-

PLE.txt 
Textdatei mit OGC-WKT String für 2D/Lage 

VA_[Bahnhofs-

ID]_2D_WKT1_SFSQL.txt 
Textdatei mit OGC-WKT String für 2D/Lage 

VA_[Bahnhofs-

ID]_2D_WKT1_GDAL.txt 
Textdatei mit OGC-WKT String für 2D/Lage 

VA_[Bahnhofs-

ID]_2D_WKT1_ESRI.txt 
Textdatei mit OGC-WKT String für 2D/Lage 

VA_[Bahnhofs-

ID]_2D_WKT2_2015.txt 
Textdatei mit OGC-WKT String für 2D/Lage 

VA_[Bahnhofs-

ID]_2D_WKT2_2018.txt 
Textdatei mit OGC-WKT String für 2D/Lage 

VA_[Bahnhofs-ID]_2D_Pro-

jJSON.json 
Parameter als JSON-String für 2D/Lage 

VA_[Bahnhofs-ID]_2D_GML.xml Parameter als XML Datei (GML) für 2D/Lage 

VA_[Bahnhofs-ID]_Proj.txt Parameter für Proj4 für 2D/Lage 

VA_[Bahnhofs-ID]_Compound_WKT1_SIM-

PLE.txt 
Textdatei mit OGC-WKT String als 2D+1D Compound 

VA_[Bahnhofs-ID]_Com-

pound_WKT1_SFSQL.txt 
Textdatei mit OGC-WKT String als 2D+1D Compound 

VA_[Bahnhofs-ID]_Com-

pound_WKT1_GDAL.txt 
Textdatei mit OGC-WKT String als 2D+1D Compound 

VA_[Bahnhofs-ID]_Com-

pound_WKT2_2015.txt 
Textdatei mit OGC-WKT String als 2D+1D Compound 

VA_[Bahnhofs-ID]_Com-

pound_WKT2_2018.txt 
Textdatei mit OGC-WKT String als 2D+1D Compound 

VA_[Bahnhofs-ID]_Compound_Pro-

jJSON.json 
Parameter der Projektion als JSON-String (als 2D+1D Com-

pound) 

VA_[Bahnhofs-ID]_ppm.png Grafische Darstellung der Maßstabsabweichungen 

 

Die letzte Datei (VA_[Bahnhofs-ID]_ppm.png) ist nur bei Bahnhöfen der Kategorien 1 bis 3 zu 

finden und in Abbildung 6 beispielhaft dargestellt. Der Nutzer der Datenbank muss prüfen, 

welche der über fünfzehn Formatvarianten seine Software interpretieren kann und, ob er nur 

Lagekoordinaten (2D) transformieren will oder auch die Definition des Höhensystems 

(2D+1D) als Metadaten mitführen will. Außerdem wird bei der Erstverwendung des Koordina-

tensystems Personenbahnhöfe (VA-Systems) empfohlen, die geographische Lage und defi-

nierte Höhe des Bahnhofssystems auf Plausibilität zu überprüfen 
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3 Workflow für Vermessung und Modellierung 

3.1 Ziel und Zweck 

Das Koordinatensystem Personenbahnhöfe (VA-System) wird in der Örtlichkeit durch ein VA-

Sondernetz realisiert. Mit den einheitlichen Parametern der Koordinatensystem Personenbahn-

höfe (VA-System) Datenbank können die Koordinaten zwischen DB_REF und VA-System um-

gewandelt werden. Das VA-System sollte über den gesamten Bahnhofsbereich und angren-

zende Gleisanlagen das führende System bei Vermessung, BIM-Modellierung, Geodatenin-

tegration und Absteckung sein, weil... 

▪ Das Koordinatensystem Personenbahnhöfe (VA-System) ist maßstabsfrei (Maßstab La-

gekoordinaten = 1). Alle topographischen Elemente und Bauteile können in ihrer tatsäch-

lichen Größe vermessen, modelliert, koordiniert und abgesteckt werden. Hierfür sind 

keine besonderen und ggf. fehleranfälligen Softwareprogramme nötig. 

▪ Das neu vermessene und ausgeglichene VA-Sondernetz enthält keine Spannungen. 

Diese Netzspannungen ergeben sich bei großflächigen geodätischen Gebrauchssyste-

men aufgrund historischer Messfehler und -ungenauigkeiten. 

▪ Ein geodätisches VA-Sondernetz kann in der Örtlichkeit einfach und zeitlich getrennt 

vom DB_REF ergänzt werden. 

▪ Das VA-Sondernetz ist durch eindeutige Transformationsparameter zum DB_REF/GK 

beschrieben. Diese Transformationsparameter können von jeder Vermessungs- und GIS 

Software interpretiert werden. In 3D-CAD/BIM-Modellierungssoftware ist wegen der 

Kleinräumigkeit keine geodätische Transformation nötig. 

▪ Bauwerkskoordinatensysteme (z.B. in Modellierungssoftware Revit) können einfach so-

wie spannungsfrei und ohne Maßstab in ein Sondernetz transformiert werden. Für diese 

3+1-Transformation (X0, Y0, Nordrichtung + Höhenniveau) ist keine Spezialsoftware nö-

tig. 

▪ Der Höhenanschluss soll über DB_REF2016 erfolgen.13 

▪ Für die 3D-Bauwerksmodellierung14 kann die vertikale Normalhöhe H (Vermessung) mit 

der kartesischen Höhe Z (3D-Software/BIM-Modellierung) gleichgesetzt werden. Das kar-

tesische Z in der dreidimensionalen CAD/BIM-Software wird als H interpretiert. Die kleine 

Krümmung von max. K=1/6380000 m wird vernachlässigt, weil sie weit unterhalb der Bau-

toleranz liegt. (Siehe Abbildung 5) 

Das folgende numerische Beispiel des Hauptbahnhofs Essen (VA 1690) zeigt die Größenord-

nung der Fehler, wenn bestimmte Eigenschaften der geodätischen Koordinatenreferenzsysteme 

nicht beachtet werden. Die Problematik wird durch Abweichungen ∆ augenscheinlich. Die Ab-

weichungen ∆ entstehen, wenn die Koordinatenwerte unsachgemäß verwendet werden oder die 

3D-Software die Erdkrümmung nicht berücksichtigt. 

Für das numerische Beispiel wurden die in Tabelle 6 gelisteten Koordinaten, ein Projektmittel-

punkt und vier Eckpunkte eines Projektgebietes berechnet. Die Koordinaten im VA-System kön-

nen als lokal gemessen angesehen werden. Die Umrechnung wurde mit den Parametern der 

VA-System Datenbank (siehe Abschnitt 2) durchgeführt. 

 
13 Diese Forderung ist nicht mathematisch begründet. Allerdings wurde festgestellt, dass einige CAD Programme die Z-Verschiebung, 

die in den WKT-Strings standardkonform angegeben ist, nicht richtig ausführen. 

14 Das VA-Sondernetz darf nicht mit dem Bauwerkskoordinatensystem verwechselt werden. Jedes Bauwerk erhält ein eigenes 

Bauwerkskoordinatensystem, das im Projektursprung (Gebäudeecke, Schnitt Achsen A-1, ...) die Verortung (e0, n0, Nordrichtung, 

Höhenniveau) des Gebäudesystem im VA-Sondernetz angibt. 
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Tabelle 6 Testkoordinaten im VA-System (Maßstab 1), UTM und DB_REF 

 1690_Essen_Hbf ETRS89/UTM32 (EPSG: 

25832) 

DB_REF/GK2 (EPSG: 

5682) 

 e[m] n [m] Easting [m] Northing [m] Rechts[m] Hoch[m] 

Mitte 5000,00 10000,00 362077,103 5701846,928 2570601,839 5702308,867 

SW 4000,00 9000,00 361050,560 5700874,559 2569615,754 5701295,050 

SO 6000,00 9000,00 363049,468 5700820,389 2571615,657 5701322,780 

NW 4000,00 11000,00 361104,737 5702873,473 2569588,021 5703294,950 

NO 6000,00 11000,00 363103,645 5702819,290 2571587,924 5703322,686 

 

Tabelle 7 zeigt große Abweichungen, wenn bei unsachgemäßer Verwendung unterschiedli-

cher Koordinatenreferenzsysteme (CRS) die Meridiankonvergenz vernachlässigt wird. Diese 

großen Abweichungen entstehen, wenn zu einem Projektbasispunkt in jeweils unterschiedli-

chen CRS lediglich die Koordinatenunterschiede addiert werden - also keine sachgemäße 

Umwandlung der Projektion oder Datumstransformation erfolgt. 

Tabelle 7 Wenn lokale Koordinatendifferenzen zu einem Basispunkt einfach unsachgemäß addiert werden entstehen auf-

grund der Meridiankonvergenz sehr große Abweichungen 

 1690_Essen_Hbf ETRS89/UTM32 DB_REF/GK2 

 e[m] n [m] ∆E vs. Add 

[m] 

∆N vs. Add 

[m] 

∆Re vs. Add 

[m] 

∆Ho vs. Add 

[m] 

Mitte 5000,00 10000,00 0,00 0,00 0,00 0,00 

S

W 

4000,00 9000,00 -26,54 27,63 13,91 -13,82 

SO 6000,00 9000,00 -27,63 -26,54 13,82 13,91 

NW 4000,00 11000,00 27,63 26,55 -13,82 -13,92 

NO 6000,00 11000,00 26,54 -27,64 -13,92 13,82 

 

Tabelle 8 zeigt typische Abweichungen, wenn bei unsachgemäßer Verwendung projizierter 

Koordinaten (z.B. Gauß-Krüger, UTM) die Streckenreduktion vernachlässigt wird. Die Stre-

ckenreduktion ist aufgrund der kartographischen Abbildung (in Abhängigkeit vom Abstand des 

Projektgebietes vom Mittelmeridian) und aufgrund der Höhe des Projektgebietes erforderlich. 

Allerdings wird die Streckenreduktion (Maßstab in der horizontalen x,y-Ebene) von 3D Model-

lierungssoftware nicht angebracht. 
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Tabelle 8 Wenn die Streckenreduktion nicht an die Strecken (hier simuliert von Mitte zu den vier Randpunkten) ange-

bracht wird, treten Abweichungen im dm-Bereich auf. Weil die 3DModellierungssoftware diese Maßstabsreduktionen nicht 

anbringt, entstehen systematisch 

 1690_Essen_Hbf ETRS89/UTM32 DB_REF/GK 

 s [m] ds 

[cm] 

s [m] ds 

[cm] 

s [m] ds [cm] 

Mitte 0,000 - 0,000 0,0 0,000 0,0 

SW 1414,214 - 1413,963 25,1 1414,280 6,6 

SO 1414,214 - 1413,958 25,6 1414,282 6,9 

NW 1414,214 - 1413,963 25,1 1414,280 6,6 

NO 1414,214 - 1413,958 25,6 1414,282 6,9 

3.2 Vermessung und Modellierung ohne Koordinatensystem Personenbahnhöfe (VA-System) 

(problematisch) 

Das DB_REF ist das geodätische, dreidimensionale Koordinatenreferenzsystem für die DB AG. Das 

Festpunktfeld ist einheitlich und deutschlandweit anforderungsgerecht und sehr genau. Die Vermes-

sung lässt sich grob in drei sequentielle Teilschritte gliedern: 

1. Verdichtung des DB_REF Festpunktfeldes (wenn Notwendig). Die Netzverdichtung er-

folgt nach allen Qualitätsvorgaben und Verfahrensvorschriften der DB InfraGO AG GB Fahr-

wege, die Punkte werden in der Örtlichkeit vermarkt und dokumentiert. 

2. Projektbezogene Verdichtung des Festpunktfeldes. Die Netzverdichtung erfolgt nach in-

genieurgeodätischen Erfordernissen im DB_REF Koordinatensystem, die Punkte werden in 

der Örtlichkeit vermarkt und dokumentiert. 

3. Messen der Objektpunkte. Die Koordinaten der Objektpunkte werden im DB_REF/GK-Sys-

tem gemessen. Dies erfolgt mit einzelpunkt Messung mittels Tachymetern. Die Punkte be-

schreiben das Bauwerk und bilden die Grundlage für die Modellierung in CAD, GIS und BIM. 

Hier entstehen zwangsläufig Differenzen zwischen Vermessung und Modellierung in 3D-

Software, weil diese die Erdkrümmung nicht berücksichtigt. 

Aus rein geodätischer Sicht ist dieses Vorgehen vollkommen unproblematisch, weil vermessungs-

technische Software mit projizierten (Gauß-Krüger) Koordinaten umgehen kann. Zum Beispiel wer-

den an Strecken Korrekturterme angebracht. Problematisch hingegen ist, das Terrestrische La-

serscanner sowie die 3D Modellierungssoftware diese Konzepte nicht kennt. 

 
Abbildung 7 Bei der Vermessung und Modellierung ohne VA-System, entsteht der Konflikt, weil die Software für die 3D-

Modellierung die Erdkrümmung und daraus resultierende Maßstäbe nicht berücksichtigt. Links: Verdichtung des DB_REF 

Festpunktfeldes. Mitte: Projektbezogene Verdichtung des Festpunktfeldes. Rechts: Wenn die gemessenen Objektpunkte 

im DB_REF vorliegen, sind sie nicht für eine 3D Bauwerksmodellierung geeignet. 

 

Die entstehenden Abweichungen sind in Tabelle 6, Tabelle 7 und Tabelle 8 beispielhaft be-

schrieben. 
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3.3 Vermessung und Modellierung mit Koordinatensystem Personenbahnhöfe (VA-System) 

(Normalfall) 

Um systematische Abweichungen zwischen Vermessung und 3D-Modellierung zu minimieren, wird 

eine Umformung der Koordinaten DB_REF → VA-System zwischen Netzverdichtung und anlassbe-

zogener Vermessung im Maßnahmenbereich empfohlen. 

1. Verdichtung des DB_REF Festpunktfeldes (wenn notwendig). Die Netzverdichtung er-

folgt nach allen Qualitätsvorgaben und Verfahrensvorschriften der Ril 883; die Festpunkte 

werden in der Örtlichkeit vermarkt und dokumentiert. Dies erfolgt nur, wenn ein gleisgeo-

metrischen Projekt Bestandteil der Aufgabenstellung ist, welches mit der Vermessung für 

den DB Fahrweg (Ingenieurvermessung) im Vorhinein abzustimmen ist.  

2. Umformung DB_REF → Koordinatensystem Personenbahnhöfe (VA-System). Die Fest-

punkte werden automatisiert in das VA-System der Verkehrsstation überführt. Hierfür stellt 

die VA-System Datenbank Parameter für alle Verkehrsstationen der DB InfraGO AG – GB 

Personenbahnhöfe bereit. 

3. Projektbezogene Verdichtung des Festpunktfeldes. Die Netzverdichtung erfolgt nach 

ingenieurgeodätischen Erfordernissen im maßstabsfreien VA-System, die Punkte werden 

in der Örtlichkeit vermarkt und dokumentiert. 

4. Messen der Objektpunkte. Die Koordinaten der Objektpunkte werden im VA-System ge-

messen. Dies erfolgt bei Projekten der DB InfraGO AG – GB Personenbahnhöfe in der Re-

gel mittels Laserscanning mit dem Ergebnis einer Punktwolke. Die Punkte beschreiben das 

Bauwerk und bilden die Grundlage für die Modellierung in CAD, GIS und BIM. Es entstehen 

keine systematischen Differenzen zwischen Vermessung und Modellierung in 3D-Software. 

Der Einfluss der Erdkrümmung kann aufgrund der Umformung vernachlässigt werden. 

 

 

Abbildung 8 Die übergeordnete Netzverdichtung und Trassierung finden im DB_REF statt. Die Festpunkte werden dann 

automatisiert in das VA-System umgeformt. Für die lokale Verdichtung, Objektvermessung und Modellierung sind keine 

geodätischen Korrekturen aufgrund des Maßstabes notwendig: Das VA-System hat den Maßstab = 1. 
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3.4 Vermessung und Modellierung mit Koordinatensystem Personenbahnhöfe (VA+ System) 

(Sonderfall) 

Um systematische Abweichungen zwischen Vermessung und 3D-Modellierung zu minimieren, 

wird in einem lokalen, maßstabsfreien System mit Höhenanschluss zum DB_REF vermessen 

und modelliert. Aus organisatorischen Projektzwängen kann aber die Situation entstehen, dass 

die Objektvermessung und Modellierung zeitlich vor der DB_REF2016-Ertüchtigung erfolgen 

muss. Dies ist vor allem der Fall, wenn kein DB REF2016 vorhanden ist und das Projekt keinen 

Gleisbezug hat. Dieser Sonderfall erfordert einen zusätzlichen Transformationsschritt, sobald 

DB_REF ertüchtigt wird. . Um den Normalfall VA-System von diesem Sonderfall zu unterschei-

den wird dieser Typ von Koordinatenreferenzsystemen mit VA+ bezeichnet. 

1. Erstellung oder projektbezogene Verdichtung eines Festpunktfelds. Eine Netzver-

dichtung15 bzw. die Erstellung erfolgt nach ingenieurgeodätischen Erfordernissen maß-

stabsfrei . Die Festpunkte werden in der Örtlichkeit vermarkt und dokumentiert. Einige 

wenige Punkte werden mittels GNSS-Messungen in DB_REF2016 ermittelt. Diese Mes-

sungen sollten mit mindestens 10 Minuten Messlänge und zwei unterschiedlichen Höhen 

erfolgen. Diese DB_REF2016 Festpunkte werden dann mithilfe der VA-Transformations-

parametern in das VA-System überführt. Der exakte Höhenanschluss erfolgt im 

DB_REF2016 über Nivellement oder, in Ausnahmefällen, über GNSS-Messungen weni-

ger Festpunkte. Die Grundlagen für das VA-System sind somit hergestellt. Alle Messun-

gen werden im VA-System ausgeglichen. Als Abschluss werden die ausgeglichenen 

Passpunkte in das DB_REF2016 Koordinatensystem transformiert und dokumentiert. 

2. Messen der Objektpunkte. Die Koordinaten der Objektpunkte werden im VA System ge-

messen. Die Punkte beschreiben das Bauwerk und bilden die Grundlage für die Modellie-

rung in CAD, GIS und BIM. Es entstehen keine systematischen Differenzen zwischen 

Vermessung und Modellierung in 3D-Software.  

3. Verdichtung des DB_REF Festpunktfeldes. Die Netzverdichtung erfolgt zeitlich nach 

der Objektvermessung nach allen Qualitätsvorgaben und Verfahrensvorschriften der 

RIL883. Die Punkte werden in der Örtlichkeit vermarkt und dokumentiert. Es muss sicher-

gestellt sein, dass ausreichend16und gut verteilte Passpunkte17 von den genutzten projekt-

bezogenen Passpunkten im DB_REF2016 Festpunktfeld enthalten sind. 

4. Ermittlung der Unterschiede und Anpassung des Transformationsparametersatzes 

Die neu gemessenen DB_REF2016 Passpunkte werden in das VA-System überführt. Im 

VA-System werden die Parameter für die Translation und Rotation gleichen Punkte ermit-

telt und der Transformationsparametersatz wird angepasst, durch eine zusätzliche Affin-

transformation. 

5. Aktualisierung Datenbank VA+System. Der neu erstellte Transformationsparameter-

satz wird an BIM_Personenbahnhoefe@deutschebahn.com gesendet.  

 
15 Hier müssen die anerkannten Regeln der Vermessungstechnik eingehalten werden. Es ist eine freie und dynamische Netzausglei-

chung durchzuführen. Die Lagerungspunkte der dynamischen Netzausgleichung werden über RTK-Messungen im DB Ref 2016 ermittel  

und anschließende transformiert  ins VA-System. 

16 Es sollten mindestens sechs identische Punkte (Passpunkte, Kontrollpunkte) vorliegen. 

17 Passpunkte sind in der Örtlichkeit identische Punkte, die sowohl im lokalen ingenieurgeodätischen VA System als auch im übergeord-

neten DB_REF vermessen und ausgeglichen wurden. Die Passpunkte sind gut verteilt, wenn Sie das Projektgebiet gleichmäßig am Rand 

umschließen, also wenn die Restklaffen in den Objektpunkten nur interpoliert, nicht extrapoliert werden. 

mailto:BIM_Personenbahnhoefe@deutschebahn.com
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Abbildung 9 Beim VA+ Sonderfall wird die Objektvermessung und Modellierung zeitlich vor der DB_REF Netzverdichtung 

durchgeführt. Dies erfordert Passpunkte (rot) und eine zweistufige Koordinatentransformation aus VA-Umformung und 

zusätzlicher Affin-Transformation. 

 

Die erste Umformung DB_REF → VA-System erfolgt mit den Parametern der VA-System Daten-

bank: 

 

(𝑅𝑒𝑐ℎ𝑡𝑠𝑤𝑒𝑟𝑡𝐷𝐵_𝑅𝐸𝐹 , 𝐻𝑜𝑐ℎ𝑤𝑒𝑟𝑡𝐷𝐵_𝑅𝐸𝐹) ↦ (𝑒𝑉𝐴, 𝑛𝑉𝐴) 

Die zweite Transformation VA System → VA+ System erfolgt mit den aus Passpunkten berech-

neten Parametern der Affintransformation: 

 (𝑒𝑉𝐴, 𝑛𝑉𝐴) ↦ (𝑒𝑉𝐴+, 𝑛𝑉𝐴+) 

Nach erfolgreicher Parameterberechnung der Affintranstransformation können diese zentral als 

WKT in die VA-Systemdatenbank übernommen werden. Es ist aber darauf zu achten, dass 

nicht alle Softwareprogramme diese Parameter richtig interpretieren (siehe Unterabschnitt 4.3). 

Die Höhe ist in beiden Systemen identisch: 

𝐻𝐷𝐵_𝑅𝐸𝐹 = 𝐻𝑉𝐴 = 𝐻𝑉𝐴+ 
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4 VA-Systeme in Anwendungssoftware 

Im Folgenden wird gezeigt, wie die neu definierten VA-Systeme in verschiedenen Softwarepro-

dukten angewendet und parametriert werden. 

 

Das lokale VA-System wird in der Modellierungssoftware angelegt. Geodaten aus dem  

DB_REF/GK-System können mit nativen Funktionen in der jeweiligen Software transform- 

iert und rücktransformiert werden. 

 

Es muss beachtet werden, dass sich die Koordinatenumrechnung nur auf die Lage bezieht. 

Wenn die Eingangspunkte eine Z-Koordinate, bzw. eine Höhe H führen, wird diese unverändert 

in den transformierten Datensatz übernommen. 18 

4.1 VA anlegen und transformieren  

Für folgende Software werden die jeweiligen schritte des VA-System anlegen und des transfor-

mieren beschrieben: 

1. QGIS 

2. Esri ArcGIS Pro 

3. Autodesk Map3D / Civil3D 

4. Korfin 

5. ProVI 

6. Card_1 

Hier ist der Workflow dargestellt: 

 

 

Abbildung 10 Workflow für jede Software  

 

Folgender CRS/WKT-String wird für das lokale VA genutzt: 

PROJCS["6649_Weixdorf_Bad", 
GEOGCS["DB_REF", DATUM["Deutsche_Bahn_Reference_System", 
SPHEROID["Bessel 1841", 6377397.155, 299.1528128, 
AUTHORITY["EPSG", "7004"]], 
AUTHORITY["EPSG", "1081"]], 
PRIMEM["Greenwich", 0, AUTHORITY["EPSG", "8901"]], 
UNIT["degree", 0.0174532925199433, AUTHORITY["EPSG", "9122"]], 
AUTHORITY["EPSG", "5681"]], 
PROJECTION["Transverse_Mercator"], 
PARAMETER["latitude_of_origin", 51.1412], 
PARAMETER["central_meridian", 13.8038], 

 
18 Einige Software führt die die Umformung der Höhe nicht durch, auch wenn eine Höhentransformation im CRS/WKT-String definiert 

wurde. 
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PARAMETER["scale_factor", 1.0000294], 
PARAMETER["false_easting", 5000], 
PARAMETER["false_northing", 10000], 
UNIT["metre", 1, AUTHORITY["EPSG", "9001"]], 
AXIS["e",EAST], AXIS["n", NORTH]] 

4.1.1 QGIS 

In QGIS kann ein neues CRS mit Hilfe eine CRS/WKT-Strings oder eines Proj-Strings angelegt 

werden. Einstellungen ⇒ Benutzerprojektionen ⇒ Plus-Icon ⇒ Eindeutigen Name vergeben ⇒ 

Format wählen (CRS/WKT- oder ein Proj-String) ⇒ String einfügen ⇒ OK 

 

Abbildung 11 Mit einem Proj-String oder CRS/WKT-String kann das lokale VA Koordinatenreferenzsystem für eine Ver-

kehrsanlage im QGIS angelegt werden. Im Beispiel wird das VA System 6649_Weixdorf_Bad angelegt. Damit kennt die 

GIS Software die vordefinierten Transformationsparameter und kann diese anwenden. 

 

Beim Anlegen des CRS, kann mit Validieren geprüft werden, ob die Struktur des Strings gültig 

ist. Bei den durch die in Abschnitt 2 beschriebenen Parametersätze ist diese Prüfung nicht er-

forderlich. Das Punktraster aus der Datei localXY.txt für kann in der Software QGIS als Layer 

hinzugefügt werden: Layer ⇒ Layer hinzufügen ⇒ Getrennte Textdatei als Layer hinzufügen. 

 

 

Abbildung 12 Das Punktraster aus der Textdatei localXY.txt eingelesen. Der GIS Software QGIS muss unter Geometrie-

definition mitgeteilt werden, dass die Koordinatenwerte der Punkte im VA System 6649_Weixdorf_Bad angegeben sind. 

 

Nachdem die Felder ausgefüllt wurden und der Button Hinzufügen ausgewählt wurde, erscheint 

folgender Dialog: 
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Abbildung 13 In der QGIS Datenbank sind mehrere Definitionen des DB_REF Datums gespeichert. Es muss die durch die 

DB InfraGO AG GB Fahrwege definierte Variante DB_REF + ETRS89 gewählt werden. 

 

Dabei ist die erste Variante vorausgewählt und kann so bestätigt werden. Der Datenbankeintrag 

Genauigkeit (1,5 Meter) ist für den Anwendungsfall irrelevant. 

 

Abbildung 14 Die aus dem lokalen VA System importieren Punkte sind jetzt auf der Karte sichtbar - egal welche Projektion 

im GIS gewählt wird. 

 

Jetzt wird die Transformation durchgeführt. Die importierten Rasterpunkte werden in ein ande-

res Koordinatenreferenzsystem, hier DB_REF/GK5, transformiert und ausgegeben. Rechtsklick 

auf Layer ⇒ Exportieren ⇒ Objekte speichern als ⇒ Format (CSV, DXF, GeoJSON...) auswäh-

len ⇒ Datei-Namen vergeben ⇒ als Koordinatenreferenzsystem EPSG:5685 auswählen ⇒ OK 

 

Für den CSV-Export muss field_1 und field_2 abgewählt werden und bei GEOMETRY AS_XY 

gewählt werden. Bei dem DXF- oder GeoJSON-Export müssen keine zusätzlichen Optionen 

konfiguriert werden. 
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Abbildung 15 Das Punktraster wird vom VA ⇒ DB_REF/GK5 konvertiert und die Punkte mit den Koordinatenwerten im 

DB_REF/GK5 in eine Textdatei Export_GK5_CSV.csv geschrieben. 

Die Punktkoordinaten der exportierten Dateien sind identisch mit dem zu erwartenden Soll-Koordi-

naten. Auch die Rücktransformation ist erfolgreich, dazu wird das erzeugte Punktraster aus Ex-

port_GK5_CSV.csv als Layer importiert und beim Export das lokale VA Koordinatenreferenzsys-

tem ausgewählt. 

4.1.2 ESRI ArcGIS Pro 

In ArcGIS Pro kann ein neues Koordinatenreferenzsystem über zwei verschiedene Wege ange-

legt weden:  

• Eine *.prj Datei mit dem CRS/WKT-String oder 

• manuell interaktiv über ein Formular. 

Die Vorzugsvariante ist die Konfiguration über eine *.prj-Datei. Dabei ist zu beachten, dass die 

Firma ESRI einen Dialekt der WKT-Strings entwickelt hat. Von der bereitgestellten Datenbank 

werden alle VA-Systeme auch mit diesem ESRI-Dialekt exportiert. Der Import des lokalen VA-

Systems wird über folgende Anweisungen durchgeführt: Rechtsklick auf Map (im Projektbaum) 

⇒ Properties ⇒ Coordinate Systems ⇒ Add Coordinate System (Plus-Icon) ⇒ Import Coordinate 

System ⇒ z.B. 6649_Weixdorf_Bad.prj auswählen (ESRI Dialekt erforderlich) ⇒ OK 
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Abbildung 16 Mit einem CRS/WKT-String im ESRI Dialekt, kann das lokale VA Koordinatenreferenzsystem für eine Ver-

kehrsanlage in ArcGIS Pro angelegt werden. Im Beispiel wird das VA System 6649_Weixdorf_Bad erzeugt. Damit kennt 

die GIS Software die vordefinierten Transformationsparameter und kann diese anwenden. 

 

Alternativ (und etwas fehleranfällig) kann das VA-System interaktiv über ein Eingabeformular 

der Software ArcGIS Pro parametriert werden: Rechtsklick auf Map (im Projektbaum) ⇒ Proper-

ties ⇒ Coordinate Systems ⇒ Add Coordinate System (Plus-Icon) ⇒ New Projected Coordinate 

System. 

 

Abbildung 17 Alternativ kann in der Software ArcGIS Pro das VA-System auch manuell parametriert werden. Die Projek-

tion und das geographische Koordinatenreferenzsystem können aus einer Liste ausgewählt werden, weil das DB_REF in 

der globalen EPSG Datenbank geführt wird. Im Beispiel wird ein lokales VA-System Weixdorf_Bad_Var2 angelegt. 

 

Punktkoordinaten aus der Textdatei werden folgendermaßen dem Projekt als Layer hinzuge-

fügt. Reiter Map ⇒ Layer ⇒ Add Data ⇒ XY Point Data 
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Abbildung 18 Punktdatei (Beispiel :Lokales_2D_Raster.txt) einlesen. Der GIS-Software ESRI ArcGIS Pro muss unter 

Coordinate System mitgeteilt werden, dass die Koordinatenwerte der Punkte im VA System 6649_Weixdorf_Bad angege-

ben sind. 

 

Als Output wird der Dateiname standardmäßig über den Prozessname erweitert, diese Bezeich-

nung kann auch geändert werden. Die Koordinatenwerte müssen den Spalten zugeordnet wer-

den und als Koordinatenreferenzsystem wird das zuvor angelegte lokale System gewählt. Der 

Prozess wird über Run ausgeführt. Als Zwischenergebnis erhält man das importierte 2D-Raster 

als Punkt-Layer angezeigt: 

 

Abbildung 19 Als Zwischenergebnis wird die importierte Punktdatei  als Punkt-Layer angezeigt 

 

Für die Transformation wird ArcGIS Pro Tool Projizieren verwendet: Reiter Analysis ⇒ Geopro-

cessing ⇒ Tools ⇒ Data Management Tools ⇒ Projections and Transformations ⇒ Project 

 

Abbildung 20 Das konvertierte Punktraster (VA ⇒ DB_REF/GK5) in eine Textdatei exportieren 

 

In einem nächsten Schritt kann nun der Export durchgeführt werden. Der einfachste Weg dafür 

ist die Nutzung der Erweiterung Data Interoperability Tools, genauer das Tool Quick Export. 
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Abbildung 21 Mit Quick Export können auch andere Export-Format, z.B. dxf gewählt werden 

 

Mit diesem Tool konnte wiederum, neben vielen anderen Formaten, *.dxf und *.json exportiert 

werden. 19. Ohne die Erweiterung Data Interoperability Tools kann die Attributtabelle jeweils um 

eine Spalte X und Y mit Datentyp double erweitert werden. 

 

 

Abbildung 22 Tabelle mit transformierten Koordinaten erzeugen und exportieren. Links: Die Werte der neu angelegten 

Spalten werden automatisch mit den transformierten Koordinaten gefüllt. Rechts: Die Tabelle mit den transformierten Ko-

ordinaten kann exportiert werden 

 

Die Berechnung durch die Software ArcGIS pro muss jetzt noch angestoßen werden Rechts-

klick auf Layer ⇒ Attribute Table ⇒ Add ⇒ Spalten hinzufügen und speichern ⇒ Rechtsklick auf 

neuen Spaltenkopf ⇒ Calculate Geometry. Es kann auch die Tabelle exportiert werden: Rechts-

klick auf Layer ⇒ Data ⇒ Export Table. 20 

In der Tabelle werden nun die richtigen DB_REF/GK Koordinaten aufgelistet. 

 
19 Beim *.csv Export kann im Werkzeug Quick Export das Koordinatenreferenzsystem nicht geändert werden. Es werden immer die ur-

sprünglichen lokalen Koordinaten exportiert. 
20 Diese Möglichkeit ist für Geometrie eher weniger gut geeignet, wenn aber schnell Punkte transformiert werden sollen, ist das eine 

schnelle Möglichkeit. 
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4.1.3 Autodesk Map3D / Civil3D 

Die Konzepte der Koordinatenreferenzsysteme, Datumstransformationen und Umrechnung sind 

in den beiden Programmen Autodesk Programme Civil3D und Map3D identisch. 

In den Autodesk Produkten kann das Koordinatenreferenzsystem nicht über einen OGC/ISO-

standardisierten CRS/WKT-String oder Proj-String angelegt werden. Autodesk verwendet ein 

eigenes XML-Schema für die Definition von Koordinatenreferenzsystemen. Die in der Daten-

bank (Abschnitt 2) spezifizierten VA-Systeme liegen deswegen zusätzlich im XML-Format vor. 

Die CRS/WKT und Proj-Strings unterscheiden sich nur im Format, aber sind mathematisch 

identisch. Die XML Spezifikation für jedes VA-System kann mit Hilfe des Befehls MAPCSLI-

BRARYIMPORT in Map3D oder Civil3D importiert und genutzt werden. Die Software muss nach 

dem Import neu gestartet werden. 

 

Das manuelle Anlegen der VA-Systeme beginnt im Ansichtsbereich Planung und Analyse: Rei-

ter Karteneinrichtung ⇒ Koordinatensystem ⇒ Erstellen ⇒ Koordinatensystemdefinition erstellen 

⇒ Weiter ⇒ mit Koordinatensystem beginnen ⇒ Weiter ⇒ neues Koordinatensystem erstellen 

(Koordinatensystemtyp: Projiziert) ⇒ Weiter 

 

Abbildung 23 Das Anlegen des VA-Systems manuell. Code, Beschreibung, Quelle und Kategorie werden durch den Nut-

zer festgelegt. Das automatische Anlegen von Koordinatenreferenzsystemen ist mit den XML-Dateien aus der Datenbank 

ebenfalls möglich. 

 

Nach der Festlegung von Code, Beschreibung, Quelle und Kategorie muss nach dem geodäti-

schen Datum EPSG:1081 gesucht und DB_REF ausgewählt werden. 
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Abbildung 24 Manuelle Parametrierung des VA-Systems in Civil3D und Map3D.  

 

Links: Für das VA-System müssen Zentralmeridian (durch VA) und Ausgangsbreitenkreis, Koordi-

naten-Offset und Maßstab festgelegt werden.  

Rechts: Der Papiermaßstab bleibt 1 und darf nicht mit dem Abbildungsmaßstab der Projektion ver-

wechselt werden.  

 

Die wichtigsten Parameter für das lokale VA-System sind Zentralmeridian, Ausgangsbreitenkreis, 

Koordinatenoffset und Maßstab der jeweiligen Verkehrsanlage. Der positive Abbildungsmaßstab 

>1 bezieht sich auf die Lagekoordinaten und ergibt sich aus der Höhe des Projektgebietes über 

dem Ellipsoid. Der Maßstab wird benötigt, um zwischen dem Naturmaßstab 1 im Planungsge-

biet/Baustelle/BIM-Projekt und den DB_REF/GK Koordinaten auf dem Ellipsoid fehlerfrei umrech-

nen zu können. 

 

Im folgenden Dialog können noch Zeichnungsgrenzen eingerichtet werden. Der Maßstab, der 

im folgenden Dialog gesetzt wird, bezieht sich auf den Papiermaßstab und muss 1 sein, die an-

deren Werte können voreingestellt bleiben. Oder Minimal- und Maximalwerte werden grob auf 

das Projektgebiet angepasst. 

 

Abbildung 25 Am Ende der manuellen Parametrierung wird das erstellte VA-System zusammengefasst und es werden 

Kopiervorlagen für andere Software-Programme angezeigt. 

 

Links: Zusammenfassung und Bestätigung.  

Rechts: Die erstellten CRS/WKT-Strings können für andere Anwendungen kopiert werden   
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Das erstellte Koordinatenreferenzsystem wird in anderen Formaten dargestellt. Mit Fertig stellen 

wird das System in der Software gespeichert. Mit dem Button Zuweisen wird das Koordinatenre-

ferenzsystem der aktuellen Darstellung zugewiesen. 

Die meisten Anwender benutzten angepasste, selbst entwickelte Tools für den Im- und Export 

von Punkten.21. 

Eine DXF Datei mit den Punkten im VA-System wird importiert. Das Symbol der Punkte kann 

nach dem Import mit dem Befehl PTYP angepasst werden. Der Zeichnung wird das Koordina-

tenreferenzsystem zugewiesen und als *.dwg gespeichert. Danach kann diese geschlossen 

werden. Nun wird eine neue *.dwg Datei angelegt, der das CRS DB_REF/GK5 (EPSG: 5685) 

System zugewiesen wird. Die vorher erstellte dwg-Datei im lokalen VA-System kann nun hinzu-

gefügt werden. Aufgabenfenster ⇒ Kartenexplorer ⇒ Rechtsklick auf Zeichnungen ⇒ Zuordnen 

⇒ zu erster Datei navigieren ⇒ Hinzufügen ⇒ OK 

 

 

Abbildung 26 Das Raster wird in beiden Koordinatenreferenzsystemen angelegt und angezeigt 

 

Im nächsten Schritt wird die Geometrie der Datei abgefragt und in der aktuellen Datei gezeich-

net. Rechtsklick auf Aktuelle Anfrage ⇒ Definieren ⇒ Position ⇒ OK ⇒ Abfragemodus ⇒ Zeich-

nen ⇒ Abfrage ausführen 

Die Transformation von DB Ref zum VA-System erfolgt in der gleichen Art.  

4.1.4 Korfin 

In der Software KorFin® und KorFin® Model kann bei Initialisierung ein Projekt u.a. entweder im 
DB_REF oder dem VA-System angelegt werden. Die Parameter des VA-Systems sind direkt bei 
Projektinitialisierung einstellbar: 

 
21 Die eigentlich naheliegenden Anweisungen Vermessungsdatenspeicher anlegen ⇒ Punkte über Rechtsklick ASCII-Punkte importieren 

lädt keine Punkte, sondern Kartenelemente. Kartenelemente lassen sich später nicht transformieren! 
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Abbildung 27: Einstellung VA-System in KorFin® Model für die Bestandsmodellierung 

 

Abbildung 28: Initialisierung des VA-Systems in KorFin® für die Planung 

 
Im KorFin® Model werden im Anschluss alle Geobasisdaten (DGM, DOPs, CityGML, ALKIS, AT-
KIS, weitere Geoinformation) aus dem amtlichen UTM-System oder dem DB_REF automatisiert in 
das VA-System transformiert und die entsprechenden Ressourcen (Fachmodell DGM, Stadtmodell, 
Fachmodelle für Geoinformationen) im VA-System erzeugt. Bei Integration der Datengrundlagen ist 
Angabe des Quellsystems in KorFin® Model erforderlich: 

 
Abbildung 29:Einstellung des Quellsystems für alle Geodaten in KorFin® Model am Beispiel DB_REF 

 
Ist eine geodätische Transformation erforderlich (z.B. bei Datengrundlagen aus UTM, alte Landes-
systeme), existieren in KorFin® Model entsprechende Voreinstellungen. Für Datengrundlagen im 
DB_REF ist nur eine Projektion (von DB_REF zum VA-System auf dem gleichen Ellipsoid) und 
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keine Transformation (mit verbundenem Datumswechsel) erforderlich, somit muss hierbei nur das 
Quellsystem korrekt angegeben werden. 
Das KorFin® Projekt wird entweder aus dem vorgenerierten KorFin® Model Projekt erstellt und liegt 
dann bereits im VA-System vor bzw. kann auch ohne Bestandsmodellierung aus Geobasisdaten 
direkt im VA-System manuel konfiguriert werden. 
Die im KorFin® Projekt geplanten und abgesetzten Objekte und Bauteile erfolgen im VA-System. 
Alle angemeldeten Quelldaten (wie z.B. Vermessungskerne, Achsen, Gradienten und weitere Fach-
modelle) erfordern ebenso eine Einstellung des Quellkoordinatensystems sowie eine Angabe zur 
geodätischen Transformation, falls erforderlich: 

 
Abbildung 30:Transformationseinstellung bei Anmeldung von IFC-Quelldaten im DB-Ref und Transformation in ein Projekt 
mit VA-System 

 
Im Falle von Fachobjekten mit Repräsentation als 3D-Geometrie (z.B. in den Formaten IFC 2x3, 
IFC 4 oder LandXML) werden die 3D-Geometriedaten punktweise vom Quellsystem über die ange-
gebene Transformationsmethodik in das VA-System transformiert. 
Für Trassierungsdaten findet eine automatisierte Transformation der Achsen, Gradienten und Über-
höhungen statt, d.h. die Radien/Krümmungen werden entsprechend des Skalierungsfaktors ange-
passt (siehe Kapitel Fehler! Verweisquelle konnte nicht gefunden werden..). 
Die im KorFin® Projekt erzeugten Ergebnisse können entweder im lokalen VA-System oder durch 
Angabe eines anderen Zielsystems exportiert werden. 

 
Abbildung 31:Exporteinstellungsdialog aus KorFin - Fachobjekte, Fachmodelle und Teilmodelle können aus dem 
Projektsystem in beliebige Systeme exportiert werden. 
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Das gesamte Projekt, eine Objektauswahl oder ein räumlich-geometrischer Modellausschnitt, kann 
aus KorFin® über verschiedene Trassierungs- (u.a. VermEsn GRA/TRA, LandXML) und BIM-
Schnittstellen (IFC 2x3, IFC 4, CPIXML) exportiert werden. KorFin® unterstützt hierbei neben dem 
Export in projiziert, kartesische Koordinaten (wie DB_REF oder VA-System), zusätzlich den Export 
in geozentrischen Koordinaten. Zudem kann für den Export ein anderer Ziel-Projektnullpunkt ange-
geben werden. 

4.1.5 ProVI 

In ProVI wird die Georeferenzierung von DB-Personenbahnhöfen in der Planung mit dem bereits im 
Programm vorhandenen Modul „Koordinatentransformation“ ermöglicht. Hierdurch sind die Anwen-
der in der Lage alle vorhandenen koordinatenbehafteten ProVI-Projektdaten oder reine Zeichnungs-
elemente zu transformieren.  

Die Transformation zwischen Landeskoordinatensystem und lokalem Koordinatensystem Personen-
bahnhöfe (VA-System) erfolgt mittels der neuen Transformationsmethode „CAPLAN-Transformation 
DB-Verkehrsanlage“ Hierbei kann sowohl in als auch aus einem Koordinatensystem Personenbahn-
höfe (VA-System) transformiert werden. Die Datengrundlage der lokalen Koordinatensystem Perso-
nenbahnhöfe (VA-System) bildet die Koordinatensystem VA-Datenbank Liste („dbref_va_syst.csv“). 

 

Abbildung 32:Oberfläche Koordinatentransformation ProVI(TRANSF) 

 

 
Abbildung 33:Bahnhofsauswahlliste ProVI 

 

Nach Auswahl des Quell- und Zielsystems über Auswahldialoge hat der Anwender noch die Mög-
lichkeit die zu transformierenden Daten auszuwählen und führt dann die gewählte Transformation 
durch. 

4.1.6 Card_1 

Bei einer Transformation in card_1 werden die Koordinaten der Projektdaten vom Quellkoordinaten-
system ins Zielkoordinatensystem umgerechnet. Das Zielkoordinatensystem ist dasjenige System, 
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in dem die Projektdaten nach der Transformation weiterbearbeitet werden. Dieses Arbeitskoordina-
tensystem für die Lage ist in card_1 immer unter der Koordinatensystemnummer 1 gespeichert. Um 
eine Transformation in card_1 berechnen zu können, müssen zunächst die Koordinatensysteme de-
finiert sein. 

Als Vorbereitung für die Transformation zwischen DB_REF und VA-System muss die VA-System 
Datenbank in den Unterordner \TRAFO\VA-System Datenbank des card_1 Programmordners ko-
piert werden. Nähere Informationen sind in der Textdatei im Ordner \TRAFO\VA-System Datenbank 
des card_1 Programmordners enthalten. 

Ein neues Koordinatensystem wird mit Hilfe der Koordinatensystemverwaltung angelegt: 

Einstellungen ⇒ Koordinatensysteme verwalten. 

 

Abbildung 34:Auswahl und Definition von Koordinatensystemen 

 
Das Anlegen eines VA-Systems erfolgt über folgende Arbeitsschritte: 

Bearbeiten ⇒ Lagesystem eingeben ⇒ Erläuternde Bezeichnung vergeben ⇒ Systemart ‚örtliches 
(lokales) Lagesystem‘ einstellen. 

 

Abbildung 35:VA-System  eingeben 

 
Im zweiten Schritt wird ein DB_REF System über die Auswahl des EPSG-Kodes gespeichert: 

Bearbeiten ⇒ Lagesystem eingeben (EPSG) ⇒ Auswahl des gewünschten DB_REF Systems über 
EPSG-Kode. 
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Abbildung 36: Auswahl des DB_REF Systems über EPSG-Code 

 

 

Abbildung 37:Eigenschaften des gespeicherten DB_REF Systems 

 

In dem anschließenden Beispiel sollen vorliegende Projektdaten im Quellsystem ‚DB_REF/GK5‘ in 
das VA-System ‚6649_Weixdorf_Bad‘ umgeformt werden. Für diese Transformationsrichtung muss 
das Zielsystem ‚6649_Weixdorf_Bad‘ unter der Nummer 1 gespeichert sein. Das Quellsystem 
‚DB_REF/GK5‘ kann unter einer beliebigen Nummer abgelegt sein.  

Sollen Projektdaten in umgekehrter Richtung transformiert werden, ist das Zielsystem 
‚DB_REF/GK5‘ entsprechend unter der Nummer 1 zu definieren. 

Es werden nur Daten (Topografie, Achsdaten, Rasterbilder, CityGML-Daten etc.) transformiert, die 
in der Lageplanansicht sichtbar sind. Im Darstellungsmenü (einfach erreichbar über F2) kann die 
Darstellung der Projektdaten gesteuert werden. 

Zunächst werden das Transformationsverfahren und die Parameter zur Umformung bestimmt: 

Vermessung ⇒ Projektdaten transformieren ⇒ mit Aktivierung der Transformationsart ‚DB_REF<-
>VASystem‘ öffnet sich automatisch die VA-Systemauswahl. 
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Abbildung 38:Projektdaten transformieren 

 

Da in der VA-Systemauswahl eine Liste aller VA-Systeme geladen wird, kann die Auswahl über 
eine Schnellsuche per ID oder Bahnhofsnamen vereinfacht werden. 

 

Abbildung 39:VA-System Auswahl 

 

 

Abbildung 40:VA-System Auswahl mit Filtereingabe 

 

Mit einem Selektionspolygon werden die zu transformierenden Daten weiter eingegrenzt. Es wer-
den alle (dargestellten) Daten innerhalb eines Selektionspolygons transformiert. Über die Funktion 
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Selektion wählen wird ein vorhandenes Selektionspolygon ausgewählt oder ein neues Selektions-
polygon angelegt. 

Die Transformation lässt sich über die Funktion Projektdaten transformieren durchführen. 

 

Abbildung 41 Projektdaten transformieren 

 

Im Dialog muss das Quellkoordinatensystem, in dem die zu transformierenden Daten vorliegen, 
festgelegt werden. Über den Button mit dem Lupensymbol kann das System ausgewählt werden. 
Mit OK wird die Transformation gestartet. 

4.1.7 Weitere 3D-Software ohne Raumbezug 

Autodesk Revit 

In der BIM Modellierungssoftware Revit sollten interner Ursprung und Projektbasispunkt iden-

tisch sein. 

Der (runde) Projektbasispunkt enthält die vier Transformationsparameter Ostwert, Nordwert, 

Höhe und Nordrichtung. Revit kennt keine Maßstabsanpassung. Der (dreieckige) Vermessungs-

punkt dient der Koordinierung von Teil- und Fachmodellen. Er wird zur Visualisierung eines ver-

einbarten Koordinierungspunktes eingesetzt - legt aber selber keine Transformationsparameter 

fest. 

Die Definition der Transformationsparameter des Projektkoordinatensystem des Revit Modells 

zum übergeordneten Koordinatensystem (Vermessung) erfolgt über Verwalten ⇒ Projektposi-

tion ⇒ Koordinaten ⇒ Koordinaten an Punkt angeben ⇒ Projektbasispunkt wählen und Werte in 

Eingabemaske eingeben.22 

 

Autodesk Navisworks/Manage 

 
22 Eine manuelle Eingabe direkt im Zeichnungselement (blaue Schrift) führt zu einer meist ungewünschten Verschiebung des Projektba-

sispunktes bzgl. der Bauwerksgeometrie. 
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Die Koordinierungssoftware dient dem Zusammenführen von semantischen 3D-Modellen in ei-

nem Koordinationsmodell. Die Teil- und Fachmodelle können auf Konsistenz und Kollisionen 

geprüft werden. Die Koordinaten werden so übernommen, wie sie zum Beispiel in der IFC, DXF 

oder RVT gespeichert wurden. In Navisworks ist keine individuelle Anpassung der Transformati-

onsparameter einzelner Datenquellen möglich. Auch der Import von objektstrukturierten GIS-

Daten ist nicht möglich. 

Desite BIM md pro 

Die Koordinierungssoftware dient der Zusammenführung von semantischen 3D-Modellen in einem 

Koordinierungsmodell. Die Teil- und Fachmodelle können auf Konsistenz und Kollisionen geprüft 

werden. Die Koordinaten werden so übernommen, wie sie zum Beispiel in der IFC, DXF oder RVT 

gespeichert wurden. In Desite wird ein lokales dreidimensionales Koordinatenreferenzsystem für 

das Gesamtprojekt festgelegt. Es ist keine individuelle Anpassung der Transformationsparameter 

einzelner Datenquellen möglich. Auch der Import von objektstrukturierten GIS-Daten ist nicht mög-

lich. 
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4.1.8 Zusammenfassung  

Tabelle 9 Zusammenfassung: Geosoftware kommt mit dem VA-System problemlos zurecht. Bei der BIM-Modellierungs-

software und BIM-Kollaborationssoftware kann eine Georeferenzierung nur als Workaround konzeptualisiert werden. 

Software Anlegen 

CRS 

Wie? Umrech-

nung 

Export Rück-

transfor-

mation 

QGIS ✓ CRS/WKT- oder  Proj- 

String 

✓ ✓ ✓ 

ESRI ArcGIS 

Pro 

✓ *.prj-Datei mit  WKT 

String (Esri Dialekt) 

✓ ✓ ✓ 

Autodesk Ci-

vil3D/ 

Map3D 

✓ XML Import ✓ ✓ ✓ 

Korfin ✓ über Eingabemaske ✓ ✓ ✓ 

Card_1 ✓ Erfolgt softwareseitig 

über Ablage der CSV 

Liste im richtigen Ord-

ner 

✓ ✓ ✓ 

ProVI ✓ Erfolgt softwareseitig 

auf Basis der Bahn-

hofsliste 

✓ ✓ ✓ 

Autodesk Revit # Koordinaten und 

Nordrichtung an PBP 

angeben 

✘ ✘ ✘ 

Autodesk 

Navisworks 

# Alle Daten müssen 

bereits im gleichen 

CRS vorliegen 

✘ ✘ ✘ 

Desite md pro # Alle Daten müssen 

bereits im gleichen 

CRS vorliegen 

✘ ✘ ✘ 
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4.2 Sonderfall: Vermessung beginnt in VA+  

Falls zeitlich vor der DB_REF/GK Netzverdichtung bereits ein lokales Koordinatenrefe-

renzsystem angelegt wurde, kann die Definition des VA um eine zusätzliche Transforma-

tion ergänzt werden, damit die bereits koordinierten Festpunkte, Objektvermessungen, 

Punktwolken und 3D-Modelle weiter in diesem lokalen Koordinatenreferenzsystem VA+ 

genutzt werden können. 

Für diesen Sonderfall, dass die Objektvermessung und Modellierung zeitlich VOR der Netzver-

dichtung im DB_REF/GK durchgeführt wird sind folgende Arbeitsschritte notwendig: 

 

1. Lokales geodätisches, maßstabsfreies Sondernetz erstellen 

• Einige wenige Punkte werden mittels GNSS-Messungen in DB_REF2016 ermittelt. 

Diese Messungen sollten mit mindestens 10 Minuten Messlänge und zwei unterschied-

lichen Höhen erfolgen. Diese DB_REF2016 Punkte werden dann mittels der VA-Trans-

formationsparameter in das VA-System überführt. Die Grundlagen für das VA-System 

sind somit hergestellt. Alle Messungen werden im VA-System ausgeglichen. Als Ab-

schluss werden die ausgeglichenen Passpunkte in das DB_REF2016 Koordinatensys-

tem transformiert und dokumentiert. 

• .Der exakte Höhenanschluss erfolgt im DB_REF2016 über Nivellement oder in Aus-

nahmefällen über GNSS-Messungen weniger Punkte. 

2. Lokale Objektvermessung zum Beispiel mittels Laserscanning und 3D-Modellierung durch-

führen 

3. Normale und Richtlinienkonforme Netzverdichtung im DB_REF/GK 

4. Umrechnung der DB_REF/GK Festpunkte ins VA. Mittels Passpunkten werden die Parame-

ter der Affintransformation zwischen VA und VA+ bestimmt. 

5. Ergänzung des CRS/WKT-Strings des VA+ Systems um Affintransformation 

6. Publikation des VA+ Systems um eindeutige Umrechnung ins DB_REF/GK zu gewährleisten 

Allerdings muss dieses Vorgehen softwareseitig vorher getestet werden, weil einige CAD- und 

GIS- Programme diese zusätzliche Transformation nicht ausreichend unterstützten. 

Es konnten einige Programme der zusätzlichen Affintransformation umgehen, allerdings 

nur in der Lage. Wenn eine lokale Höhe angenommen wurde, konnte der Offset für die Z-

Koordinate nicht automatisch von der Software angebracht werden. 
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5 Umgang mit Trassendaten 

Die Trassierung und Änderung an der Trassierung finden in den projizierten DB_REF Systemen 
statt. Die beschriebene Transformation dient der Vereinfachung einer angelagerten Planung einer 
Verkehrsanlage und der Integration der Trassendaten in das VA-System. Die maßgeblichen Para-
meter der Richtlinien bleiben von der Transformation unberührt, da diese sich auf die geplante Tras-
sierung im DB_REF beziehen. 

Im VA System erfolgt keine Trassierung und somit auch keine gleisgeomertische und Fahrdynami-
sche Prüfung 

5.1 Trasse als Polylinie Transformieren 

Dieses Vorgehen beschreibt die Transformation der Trasse mit dem Ergebnis einer Polylinie im Ko-
ordinatensystem Personenbahnhöfe (VA-System). Grundlagen sind die bereitgestellten Trassenda-
ten, welche i.d.R. als Elemente im .mdb Format bereitgestellt werden. 

⦁ Erstellung einer Polylinie (Segmentierung) aus der Trasse, so dass der Abstand zwischen Poly-
linie und beigestellten Trassendaten kleiner 1mm beträgt 

⦁ Überführung der Polylinienpunkte in das Koordinatensystem Personenbahnhöfe (VA-System) 
durch Umformung der Einzelpunkte mittels Transformationsparameter in das Koordinatensystem 
Personenbahnhöfe 

5.1.1 Transformation Trassendaten in Polylinie 

Zur Überprüfung der Ergebnisse sollte anschließend ein Abgleich des Abstands zwischen Polylinie 
und beigestellter Trassendaten durchgeführt werden. Um Trassenelementinformationen auch in der 
Polylinie bereitzustellen, können diese als Attribute an die Einzelpunkte der Polylinie angehangen 
werden:  

⦁ Trassennummer 

⦁ Kilometrierung 

⦁ Überhöhung 

⦁ Trassenelement (Gerade, Kreisbogen …) 

⦁ Informationen zum Trassenelement (Radius im DB_REF) 

5.2 Trassenelemente Transformieren 

Beim Übergang von DB-REF in das VA-System können auch Trassierungsdaten transformiert wer-
den. Hierbei muss die Winkeländerung und der Skalierungsfaktor berücksichtigt werden, d.h. aus 
einem Radius von „7.000,0 m“ wird je nach Höhe und Abstand des Bezugsmeridians vom VA-Sys-
tem zum DB_REF ein Radius von z.B. „7000,0658 m“. Die Änderungen betreffen 

• Radien bei Kreisbögen, 

• Start- und Endkrümmungen bei Übergangsbögen, 

• Halbmesser bei Gradienten sowie 

• stationsabhängigen Daten, wie die Station zum Überhöhungsanfang, Überhöhungsende. 

Die Transformation in das VA-System erfolgt elementweise, d.h. jedes Achselement wird für sich 
genommen transformiert. Somit bleibt die Elementabfolge erhalten. Hierbei sollen die Hauptpunkte 
der Achse (die Elementübergänge) ohne Transformationsfehler abgebildet werden. 

Die Transformation erfolgt über ein Trassierungspaket aus 
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• Gleisachse und Gleisgradiente mit interner Stationierung (die Gleisgradiente bezieht ihre 
Stationen aus der Gleisachse) oder 

Streckenachse, Gleisachse und Gleisgradiente mit Fremdstationierung (die Gleisgradiente be-

zieht sich über ihre Stationen über die Streckenachse inklusive Stationssprüngen. 

Eine Überprüfung mit der Polylinien Transformation sollte als Qualitätssicherung erfolgen und 

dokumentiert werden. Außerdem sollten die transformierten Trassenelemente auch wieder in 

das DB_REF, gleichen Workflow, transformiert werden, um die Richtigkeit des Workflows in 

beide Richtungen sicher zu stellen. 

5.2.1 Transformation in KorFin 

Die Transformation erfolgt entweder 

• explizit, d.h. es werden im Projekt die bereits transformierten Trassendaten angemeldet und 
mit diesen weiter gearbeitet oder 

• implizit, d.h. es werden die Trassierungsdaten im KorFin-Projekt mit Quelle DB_REF ange-
meldet und zur Laufzeit in das VA-System transformiert. 

Im ersten Schritt wird ein Projekt mit der Parametrik des VA-Systems angelegt: 

 

Abbildung 42:KorFin Projekt anlegen 

 

Danach erfolgt die Integration der Streckenachse als Fachobjekt:

 

Abbildung 43:KorFin Streckenachse integrieren 
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Hierzu wird ein Fachobjekt „Gleis“ angelegt und die Streckenachse (z.B. im TRA-Format) definiert. 
Es erfolgt die Einstellung der Transformation von DB_REF in das Projektsystem (VA-System). 

Im Anschluss erfolgt die Definition der Gleise. Hierzu werden Fachobjekte für die Gleise angelegt, 
die Transformation eingestellt, der Rückbezug zur Streckenachse definiert und die Daten für Achse 
und Gradiente angemeldet (GRA + TRA). 

 

Abbildung 44:KorFin Definition der Gleise 

 

Die angezeigten Gleise sind bereits die transformierten Gleisdaten im VA-System. 

Anschließend können noch zusätzliche davon abhängige Fachobjekte definiert werden (z.B. 
Schwellen, Schotterbett, Schienen, etc.). 

Danach können die (implizit) angemeldeten Daten im VA-System exportiert werden. Zuerst wird die 
Streckenachse exportiert (TRA der Streckenachse): 

 

Abbildung 45:KorFin Export der Streckenachse in das VA-System 
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Danach erfolgt der Export der Gleisachsen (TRA + GRA, wobei sich die Gradiente je nach Einstel-
lung auf die Stationen der Streckenachse beziehen kann): 

 

Abbildung 46:KorFin Export der Gleisachse 

 

Die Ausgabe erfolgt ohne zusätzliche Transformationseinstellung im Projektsystem (VA-System). 

Zur Verifikation kann die Ausgabe der abgeleiteten Volumenkörper der Gleisachsen (z.B. Schotter-
bett, Schienen, Schwellen) zusätzlich im IFC-Format erfolgen (IFC 2x3 oder IFC4). Diese enthalten 
die 3D-Geometrie-Daten als Dreiecksnetze. 

 

Abbildung 47:KorFin Export der Gleisachse in ein IFC 
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Neben der direkten Integration bzw. Konvertierung der Daten über das GRA/TRA-Format, können 
mittels des Zusatzwerkszeugs „MultiApp“ der A+S Consult GmbH als projektbezogenes Unterstüt-
zungs-Tool die Daten aus dem AVANI-Export (MDB-Datei) automatisiert in ein GRA/TRA-Format im 
DB_REF oder VA-System konvertiert werden. 

 

Abbildung 48:KorFin Konvertierung MDB zu GRA/TRA  

 

Das Ergebnis sind CSV-Dateien, in welcher die Strecken- und Gleisdaten im GRA/TRA-Format re-
ferenziert werden. Die entsprechende CSV-Datei kann in KorFin® direkt angemeldet werden und 
enthält die Definition aller Strecken- und Gleisachsen im DB-REF oder VA-System. 

5.2.1.1 Anmerkungen zu Transformationsfehlern und Toleranzen in KorFin 

Die transformierten Trassierungsdaten erhalten durch die elementweise, lokale Transformation sehr 
geringfügige Richtungsknicke. Dies lässt sich mathematisch bei Beibehaltung der Elementfolge 
nicht vermeiden, da z.B. zwei aneinanderstoßende Geraden, ohne Richtungsknick nach einer Um-
projektion auf einen anderen Bezugsmeridian, zwingend einen Richtungsknick haben müssen. Dies 
gilt für Kreisbögen und Übergangsbögen analog. Der Fehler lässt sich nur durch künstliche Ele-
mentverfeinerung begrenzen, jedoch nicht vollständig eliminieren (d.h. durch Teilung eines Elemen-
tes in zwei oder mehrere Teilelemente). 
 
In das VA-System werden die Achselemente jeweils lokal optimal transformiert: 
Die exakte Transformation und Stetigkeit in den Achshauptpunkte wird gewährleistetet (es entste-
hen keine Sprünge). Weiterhin werden die Richtungstangenten der Elemente entsprechend der 
Transformation optimal angepasst. Hierbei können numerisch minimale Knicke mit Größenordnung 
„0,0000X Gon“ entstehen (siehe Prüfprotokoll). Die entstehenden minimalen Knicke sind weit weg 
von den Grenzwerten nach Richtlinie 883.5000, Seite 2 (< „0,063662 Gon“). Eine Neueinrechnung 
der Elemente zur Vermeidung dieser numerischen „Knicke“ ist für Anwendungsfälle außerhalb der 
Trassierung (welche auch weiterhin im DB_REF stattfindet) unzweckmäßig, da dies die vorrangige 
Genauigkeit der Transformation in den Achshauptpunkten mathematisch verletzen würde. Eine - 
wenn auch geringfügige - Verschiebung der Achshauptpunkte weg vom eigentlich exakten Transfor-
mationspunkt ist außerhalb des Anwendungsfalls Vermessung/Trassierung als schwerwiegender zu 
betrachten als numerisch minimal entstehende Knicke. In der praktischen Anwendung sind diese 
Richtungsknicke allerdings im VA-System irrelevant, da hier keine gleisgeometrische / fahrdynami-
sche Prüfung stattfindet. 
Weiterhin entsteht eine geringfügige Lageabweichung innerhalb des Elements. Diese ist bei gege-
benen maximalen Elementlängen im Bahnhofsbereich (< 1km Länge) vernachlässigbar und in der 
praktischen Anwendung im Submillimeterbereich. 
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5.2.2 Planungsworkflow mit ProVI unter Berücksichtigung der VA-Systeme 

ProVI ist eine effiziente und praxisnahe BIM-Lösung für die Planung von Verkehrsinfra-

strukturen wie Straße, Schiene und Leit- und Sicherungstechnik (LST). Mit der Einführung 

der lokalen Bahnhofsysteme ergeben sich keine umfangreichen Änderungen am bewähr-

ten Planungsablauf in ProVI. Am Beginn jeden Projekts steht das Zusammentragen von 

Planungsgrundlagen, wie z.B. das Einlesen von Gleisnetz- oder Achsdaten über die um-

fangreichen Schnittstellen. Nachdem alle planungsrelevanten Grundlagen in der Daten-

bank vorhanden sind, werden alle notwendigen koordinatenbasierten Daten von ihren 

Quellsystemen in das entsprechende VA-System mittels Koordinatentransformation trans-

formiert. Im Anschluss wird auf Grundlage dieser transformierten Daten die weitere Pla-

nung wie bekannt fortgeführt und abgeschlossen. Wenn notwendig, können während des 

Planungsprozesses oder zum Ende jegliche Daten vom lokalen VA-System in die Landes-

koordinatensysteme zurücktransformiert werden. 

 
Abbildung 49:ProVI-Workflow mit VA-System 

 

5.2.3 Card_1 

5.2.3.1 Berechnung der Bahnsteigkante im globalen DB_REF Koordinatensystem 

Zur Ermittlung der Abstands- und Höhenmaße der Bahnsteigkante (BSK) werden diese 

im DB_REF Koordinatensystem berechnet. Um den Abstand der Bahnsteigkante zu er-

mitteln, wird der Bahnsteiggenerator im globalen DB_REF System verwendet. Dort befin-

den sich auch Funktionen zur automatischen Generierung der BSK nach der RIL813. Zu 

empfehlen ist die Berechnung der BSK in einem größeren Bereich als vom Auftraggeber 

bestellt. Somit kann der Bahnsteig zu einem späteren Zeitpunkt im lokalen VA-System be-

liebig verschoben werden. Bei der Erstellung des Bahnsteiges mit dem Bahnsteiggenera-

tor wird automatisch eine Topografielinie (Polylinie) der Bahnsteigkante in card_1 in der 

Schicht des Bahnsteiggenerators (BSGAAAAAVV, A = Achsnummer, V = Vorgangsnum-

mer) erzeugt, siehe Abbildung 1. Diese Linie sollte in eine entsprechende Schicht (z.B. 

„BSK-Bezugslinie“) kopiert werden. 

 

Abbildung 50:Card_1 Auswahl der Bahnsteigkantenlinie aus der automatisch erstellten Schicht des Bahnsteiggenerators 

Erfassung der 
Planungsgrundlagen (z.B. 

Trassendaten)

Transformation aller Daten 
in das VA-System

Planung im VA-System
ggf. Rücktransformation 

vom VA-System in 
Landeskoordinatensystem
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Info: Eine detaillierte Anleitung zur Bahnsteiggenerierung ist der Hilfe von card_1 zu ent-

nehmen 

5.2.3.2 Transformation der Grunddaten sowie der BSK-Bezugslinie in das lokale VA-System 

Ist die Topografielinie in die entsprechende Schicht abgelegt, kann mit der Transformation 

begonnen werden. Diese befindet sich unter Vermessung → Projektdaten transformieren. 

 

Info: Eine detaillierte Anleitung zur Transformation ist der Hilfe von card_1 zu entnehmen 

5.2.3.3 Planung des Bahnsteiges im lokalen VA-System 

Nach der Transformation der Daten kann mit der Planung des Bahnsteiges im lokalen VA-

System begonnen werden. Hierbei muss man beachten, dass durch die Transformation 

die Achsen zwar weiterhin eingerechnet sind, aber ihre wahre Lage durch den Erhalt der 

Trassierungsparameter verloren ist. Deswegen wurde bereits im Schritt 1 eine Topogra-

fielinie erzeugt, welche sich auf die Gleisachse des DB_REF Systems bezieht. Auf diese 

Linie kann nun im Bahnsteiggenerator unter „Grunddaten“ im lokalen Koordinatensystem 

zugegriffen werden. Somit bezieht sich die Bahnsteigkante auf die transformierte Polyli-

nie. 

 

Abbildung 51:Card_1 Bahnsteigkantenbezug auf Topografielinie 




